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Important Information

Except as otherwise expressly stated in the License that accompanies a
program, Texas Instruments makes no warranty, either express or implied,
including but not limited to any implied warranties of merchantability and
fitness for a particular purpose, regarding any programs or book materials and
makes such materials available solely on an "as-is" basis. In no event shall
Texas Instruments be liable to anyone for special, collateral, incidental, or
consequential damages in connection with or arising out of the purchase or
use of these materials, and the sole and exclusive liability of Texas
Instruments, regardless of the form of action, shall not exceed the amount set
forth in the license for the program. Moreover, Texas Instruments shall not be
liable for any claim of any kind whatsoever against the use of these materials
by any other party.

FCC Statement

Note: This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular
installation.

If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

*  Connectthe equipmentinto an outlet on a circuit different from that to
which the receiver is connected.

» Consultthe dealer or an experienced radio/TV technician for help.

Modifications not expressly approved by the manufacturer could void the user’s
authority to operate the equipment under FCC rules.

Vernier DataQuest™ is a trademark of its respective owner.

© 2010 - 2013 Texas Instruments Incorporated
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Getting Started with the TI-Nspire™ CX
Handheld

The TI-Nspire™ CX handheld and the TI-Nspire™ CX CAS handheld are the
newest handhelds in the TI-Nspire™ family of products. Featuring a backlit color
display and a slimmer form, the handhelds provide touchpad navigation,
dynamic graphing, and interactive computer features.

The handhelds and the TI-Nspire™ software share the same functionality,
enabling you to transfer class assignments from the handheld to the computer
or transfer documents to the handheld when you need to be mobile. Start
assignments at school, and then finish the work at home to take advantage of
the software’s full-color display and easy-to-use navigation. Use the software to
download the latest software and handheld operating system updates as they
become available to ensure you have the latest enhancements.

This guide covers both the TI-Nspire™ CX handheld and the TI-Nspire™ CX
CAS handheld. While they operate identically in many ways, there are a few
distinctions. If the TI-Nspire™ CX CAS handheld has additional functionality, it
is pointed out and the CAS operation is described.

About CAS

With CAS, or the Computer Algebra System, you can:
*  Perform both symbolic and numeric calculations.
+ Factor and expand expressions and solve for common denominators.

TI-Nspire™ CAS technology makes it possible to recognize, simplify, and
calculate math expressions, preserving the symbols including variables and
terms such as “e” and =.

This ability to enter and view equations and expressions on screen as they
appear in textbooks is especially useful for step-by-step, arithmetic, algebraic,
and calculus calculations.
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TI-Nspire™ CX Handheld Keys

Use the TI-Nspire™ Touchpad as you would a laptop touchpad. You can also press the
outer edges to move right, left, up, and down.

esc] Removes menus or dialog urnson the
R dial ] (@on] T h
boxes from the screen. Also stops TI-PESpe X handheld. Ifthe
a calculation in progress. handheld is on, this
key displays th
Opens the Scratchpad for hi{nd;ssf::?g:n ©
performing quick calculations and ’
graphing. Opensthe
Moves to the next entry field. Document menu.
(menu] Displays the
Makes the next character o . .p 4
typed upper-case application or
: - context menu.
Provides access to the
del | Deletes the
function or character shown above @ (=] .
h key. Also enables shortcutsin L previous
eac ) y.. ) Ea character.
combination with other keys.
(varDisplays
Ao stored variables.
o= G
i Py Evaluatesan
(M@ .
— expression,
BEOOEEBEGE @) | executesan
g g g 8 g S ] g @] | instruction, or
7] -]
= = | selectsamenu
k\ @ %'1945 Imgnn-. j Item
s P

Note: Ap symbol on a key indicates access to multiple options. To access an option, press
repeatedly or use the arrow keys on the Touchpad. Press or click to select the
option.

Preparing the TI-Nspire™ CX Handheld for Use
The TI-Nspire™ CX handheld comes equipped with an Li-ion rechargeable

battery. The handheld also comes with the following accessories:

+  Standard mini-B to mini-B USB cable for transferring files to another
handheld

« Standard A to mini-B USB cable for transferring files to and from a
computer and for charging the battery
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Charging the Handheld
1. [Ifthere is a pull tab on the battery, remove the tab before charging.

2. Charge the battery for at least four hours to ensure optimum performance.

Turning On the TI-Nspire™ Handheld for the First Time

» After charging the battery, press to turn on the handheld.
A progress bar is displayed while the operating system loads. Next,
choose preferences for language and font size when prompted.

Note: To turn the handheld off, press [ctn] [Glon]. The settings and memory
contents are retained.

Using Automatic Power Down™

To prolong battery life, the Automatic Power Down™ (APD™) feature turns off
the handheld after three minutes of inactivity. When this happens, press
to turn the handheld on and return to the last document or last menu accessed.
To change the default setting, press (5] 3] to access the Handheld Setup
screen where you can change the Power Standby setting.

Note: For more information about setting up the handheld, see Configuring
Handhelds.

Choosing a Language
After the OS is loaded, select a preferred language.

Choose Language

Choose your language

English (L1.5.)

g gplact OK

[ox) [cancel

1. Press) to open the drop-down list.

2. Press v to scroll through the languages, and then press (%] or to
select a language.
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3. Press [tab]to highlight the OK button, and then press (%] or to save the
language selection.

Choosing a Font Size
Next, select a font size for the display.

Font Size

Chooge font size

Small ABCDEFabcdef123456
Medium ABCDEFabcdef123456
Large ABCDEFabedef123456

1. Press) to open the drop-down list.

2. Press ¥ to highlight the font size, and then press (%] or to selectit.
3. Press to highlight the OK button, and then press (] or [enter].

The Welcome! screen opens.

The next screen is your # home for
TI-Mzpire™ CX handheld. Here you can add
applications to your open documents.

The center of the touchpad can he used ta
select or grab. Click to select G now.

4. To continue, press || or to select OK.
The Home screen opens.
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Adjusting the Brightness of the Backlighting

The screen on the TI-Nspire™ CX handheld is backlit making it easier to use in
all lighting conditions. By default, the brightness setting is medium. To adjust
the backlight brightness:

+  Dimmer: Press and hold and tap (-].
+  Brighter: Press [etn] and tap [+].

Using the TI-Nspire™ Touchpad

Use the Touchpad to navigate or complete any task that can be completed
using the arrow and Enter keys. Use the Touchpad to navigate in two ways:

* Useitlike a computer touchpad by moving your fingertip in a sliding
motion on the center area of the Touchpad to activate and move the
mouse pointer. Click or tap the center of the Touchpad to selecta menu
option or complete an action.

*  Press the arrow keys on the outside edge of the Touchpad to nudge the

mouse pointer up, down, left, or right, and then click or press
to complete an action.

If you hold down an arrow key, the mouse pointer continues to move in that
direction.

Note: If the mouse pointer is visible on a command or file, click or tap in the
center of the Touchpad to select that command or file. If the command or file is
highlighted, move the pointer over that item or press to select it.
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When working in an application, use the Touchpad to access more information
about problems. For example, hovering over a Graphs & Geometry object
displays information about variables used in that object and about tools that
are available.

Some users prefer to customize their Touchpad settings; to speed up or slow
down their pointer, or to enable tap to click. To change the default settings for
the Touchpad, see Configuring Handhelds.

Understanding the Scratchpad

Use the Scratchpad to make quick calculations and graphs without affecting
the current TI-Nspire™ document. For example, when you need a quick way to
test a calculation before you add it to a document, you can open the
Scratchpad application and perform the calculation. Then, you can either
discard the calculation or add it to a document. For more information about the
Scratchpad, see Using the Scratchpad.

Using the Home Screen

The Home screen provides a starting point for all activities performed on a
handheld:

»  Opening the scratchpad for quick calculations and graphing
»  Creating new documents

* Opening and managing existing documents

* Opening the scratchpad for quick calculations and graphing
» Defining settings and viewing status

*  Viewing hints for operating the handheld

*  Accessing recent documents

*  Returning to the current document

Note: To return to the Home screen from any other location, press [ghon].

Home Screen Options

Menu Option | Purpose

Scratchpad

Getting Started with the TI-Nspire™ CX Handheld 11



Menu Option | Purpose

Use the Scratchpad menu options to open a Calculator or Graph application
without affecting your document.

While in Scratchpad, press to toggle between Scratchpad applications:
Calculate and Graph.

Calculate Opens the Scratchpad with a Calculator application
active. From the Home screen, type [A].

Graph Opens the Scratchpad with a Graph application active.
From the Home screen, type [B].

Documents

To select options for working with documents, press the associated number
or use the Touchpad to select an icon then press or [enter].

New Document | Opens a new TI-Nspire™ document with available
applications listed.

My Documents | Opens the file browser where you can open existing
TI-Nspire™ documents or send files to others.

Recent Lists the five most recently saved documents.
Current Goes to the document that is currently open.
Settings Check the status of the handheld and change settings.

Application icons

To add a new page to the current document, select an application icon. If no
documentis open, a new document opens with the selected application on
a new page.

Calculator Adds a page to a document for entering and evaluating

Ii math expressions.
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Menu Option | Purpose

Graphs Adds a page for graphing and exploring functions.
Geometry Adds a page for creating and exploring geometric
- shapes.
|!Ls

Lists & Adds a page for working with data in tables.
Spreadsheet
Data & Adds a page and provides tools used to visualize sets of
Statistics data in different types of plots and provides tools for
manipulating data sets to explore relationships between
U the sets of data.
Notes Provides text editing functions for adding text to

TI-Nspire™ documents for use as notes or to share with
other users.

Vernier Adds a page for collecting and analyzing data from
DataQuest™ | sensors or probes.

Y

To learn more about applications and documents, see Working with
Documents on TI-Nspire™ Handhelds.

Getting Started with the TI-Nspire™ CX Handheld 13



The TI-Nspire™ Handheld Screen

The icons on the handheld screen provide information about the status of
handheld operations and provide an easy way to access and change settings.
This screen shows the icons, which are described below.

O 09 ©09
0_[.1 1.1||'1.} Ij Bocument 1% Ed.&‘“";.'ﬁ
' 6]

Icon Function

(1 TS Page scrolling arrows - Use the touchpad and these arrows
to scroll through the pages in a document.

(2] | 14 | Page tabs - Indicate the problem number followed by the
page number. If problems are named, move the Touchpad
pointer over the tab to view the page name.

(3) Document name - Shows the current document name. Click
here to access the Documents menu. An asterisk by the
document name indicates changes were made since the
document was last saved.

(4) ﬁ Press to Test - Indicates that the handheld is in Press-to-Test
mode.
(5) = Login status - Shows whether the handheld is searching for

an access point (blinking), found an access point (solid), not
communicating, connected and ready to log in (a blinking
arrow), or logged in and charged (a solid arrow). Click here
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Icon Function

to view Settings & Status.

ears | [esnif [an] or s status.

I Settings & Status:

*  Hover the cursor over the icon to show the angle mode
setting in effect for the active application and the level of
the battery supply.

* Click the icon to open the Settings menu.

(8] x Close document - Click here to close the current document. If
information is unsaved, save or discard when prompted.

Using Hints

Hints are quick tips available throughout the software on the handheld. There
are several easy ways to access Hints:

+  Press [etr] [tg].

*  Some dialog boxes contain a question mark icon. Click this icon to open
Hints for that task.

To scroll through the Hints, use the Touchpad or arrow keys:
« To page down, press [ctr] (3].
+  To page up, press [cn] [9].
+ To go to the end of the Hints file, press [ctn] (1].
+  To go back to the beginning of the file, press [et] (7].

Getting Started with the TI-Nspire™ CX Handheld 15



Using Keyboard Shortcuts

Use the following keyboard shortcuts to perform common functions. You can
also perform all shortcuts performed by selecting options from menus.

Getting Help
Open Hints (etr]
Editing Text
Cut (o] [X]
Copy ED
Paste [etr]
Undo (o] (2]
ED
Redo (etn ]
Toggle approximate and exact results (etrt])
English: Change key to include appropriate (F]
accent
Chinese: Insert character
Inserting Characters and Symbols in a document
Display character/symbol palette (etrt])
Underscore R
Display math template palette {3
Backslash (\) B
Manual data capture point (etn] 2]
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Clear (ot ) (1]
Caps Lock (etrt ]
Store (etn ]
Square brackets D
Curly brackets (] (3]
Display Trig symbol palette
Equals symbol (=]
Display pi symbols palette

(=, /, 6, and so on),

Display equality/inequality palette (etn] (=)
>, <, #<,>and|)

Display marks and letter symbols palette 2>
(?!$ "))

Square root (etn] (2]
log (etr]
In (etr]
ans (etn] ()
Managing Documents

Open document menu
Open document (etn] [O)
Close document [etr] [w]
Create new document (et ] [N]
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Insert new page

(en] (1]

Select application (etn] (K]
Save current document [etn] [S)
ED
Navigation
Top of page etr]
End of page etr]
Page Up (etn] [9]
Page Down (etr]
Up a level in the hierarchy EPN
Down a level in the hierarchy (] w
Context menu for selection
Extends selection in direction of arrow Any arrow
Navigating in Documents
Displays previous page (etri] 4
Displays next page (et ] p
Displays Page Sorter (etn] a
Exits Page Sorter (etrn] w
Switch between applications on a split page (etrt])
Moves focus backward within page

Wizards and Templates
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Add a column to a matrix after the current
column

Add a row to a matrix after the current row
Integration template
Derivative template (-]
Math template palette (&Jor [etn] [F]
Fraction template (en] (=]
Modifying Display

Increase contrast etrl)
Decrease contrast (o] (=]
Power off etr]
Using Application-Specific Shortcuts

Select all in Notes or Program Editor [etn] [A]
Check syntax and store (in Program Editor) (etrt]
Insert Data Collection console (en] (D]
Find (in Program Editor) (en]  [F]
Hide/Show Entry Line (in Graph or Geometry) (] [q]
Go To (in Lists & Spreadsheet, Program Editor)

Find and Replace (In Program Editor) (] [H)
Insert math expression box (in Notes) (] [Mm]
Open the Scratchpad
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Recalculate (in Lists & Spreadsheet) (] [R]

Add Function Table (in Lists & Spreadsheet, [0
Graph, and Geometry)
Group/ungroup (etn] /[en] (6]
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Using the Scratchpad

The Scratchpad is a feature of the TI-Nspire™ CX handheld that lets you
quickly:

+  Evaluate math expressions.

»  Graph functions.

Opening and Closing the Scratchpad

» From the Home screen, press to open the Scratchpad.

The first time you open the Scratchpad, a blank page opens with the
Calculator active.

Scratchpad <

» Press to alternate between the Calculate and Graph pages.

Using the Scratchpad 21



78:1.151

Define cyb(n:]=n3

c:xbl:sjl

Scratchpad <

7.394

> Press to see the Scratchpad Calculate or Scratchpad Graph menu.
These menus are subsets of the TI-Nspire™ menus for the Calculator and
Graphs applications. For complete listings of those menus, see the
documentation for those applications.

» Press to close the Scratchpad.

Calculating with Scratchpad

From the Scratchpad Calculate page, enter a math expression on the entry
line, and then press to evaluate the expression. Expressions are
displayed in standard mathematical notation as you enter them.

Each evaluated expression and result becomes part of the Scratchpad history,
displayed above the entry line.

Entering Simple Math Expressions

Note: To enter a negative number, press ) and then type the number.
28.43

Suppose you wantto evaluate 12

1. Selectthe entry line in the work area.

2. Type 2 [~] 8to begin the expression.

»8
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3. Press) to return the cursor to the baseline, and then complete the
expression by typing:

(x] 43([] 12

28.43/12

4. Press to evaluate the expression.

The expression is displayed in standard mathematical notation, and the
resultis displayed on the right side of the page.

8.4:‘5 2752

2743
12 3

Note: You can force a decimal approximation in a result by pressing

(etrr] instead of [enter].
2543 917.333

=\ 4

- g

Pressing [etrl] forces the approximate result.

Note: Results formatting can also be adjusted in settings. For more information
about customizing settings, see Configuring Handhelds.

Inserting Items from the Catalog

You can use the Catalog to insert functions and commands, symbols, and
expression templates into the entry line.

1. Press [@] to open the Catalog. By default, the first tab is displayed, which
lists all commands and functions in alphabetical order.
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Catalog for a
non-CAS
handheld

3

[ #\wWizards On

Catalog for a
CAS handheld

2. Ifthe function you are inserting is visible in the list, select it and press
to insert it.

3. Ifthe function is not visible:
a) Press a letter key to jump to the entries that begin with that letter.
b) Press w or a as necessary to highlight the item you are inserting.

c) Click a numbered tab to list functions by category: math functions,
symbols, math templates, library objects, and value for standard
measurement units (CAS).

d) Press to insert the item into the entry line.

Using an Expression Template

Templates help you enter matrices, piecewise functions, systems of equations,
integrals, derivatives, products, and other math expressions.
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> b

For example, suppose you want to evaluate »=3

1. Press to open the Template palette.

(=]
n =10
d=]

2. Select
The template appears on the entry line with small blocks representing
elements that you can enter. A cursor appears next to one of the elements
to show that you can type a value for that element.

to insert the algebraic sum template.

3. Use the arrow keys to move the cursor to each element’s position, and
type a value or expression for each element.

> W

n=3
4. Press to evaluate the expression.

i(n)

n=3

25

Inserting Expressions Using a Wizard
You can use a wizard to simplify entering some expressions. The wizard
contains labeled boxes to help you enter the arguments in the expression.

For example, suppose you want to fita y=mx+b linear regression model to the
following two lists:

{1,2,3,4,5}
{5.,8,11,14,17}

1. Press to open the Catalog and show the alphabetic list of functions.
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2. Click inside the list, and then press [L] to jump to the entries that begin with
o

Press w as necessary to highlight LinRegMx.

4. Ifthe Wizards On option is not checked, press to highlight
Wizards On.

Press to change the setting.
Press to highlight LinRegMx again.

LinRegMx
functionin a
non-CAS
handheld

#\Wizards On

| LinReghtx X, v [ [Freq] [. Category, Include]]

LinRegMx

) functionina
lirni i CAS handheld
limnitg

LinFeghdx

LinRegBx

#\Wizards On

LinRegBx X, [.[Freq][. Categary, Include]]

7. Press [enter].

A wizard opens, giving you a labeled box to type each argument.
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12.

‘P Linear Regression (mx+h)

X List: | [&
¥ List: | |
Sawve RegEgn to: | fi |
Frequency List: | 1 |
|
=

Category List: |

Include Categaties: |

Type{1,2,3,4,5}as X List.
Press to move to the Y List field.

. Type {5,8,11,14,17} as Y List.

. Ifyou want to store the regression equation in a specific variable, press

(tab], and then replace Save RegEqn To with the name of the function
variable (f1 through f99).

Click OK to close the wizard and insert the expression into the entry line.

The expression is inserted along with statements to copy the regression
equation and display the variable stat.results, which will contain the
results.

LinRegMx {1,2,3,4,5},{5,8,11,14,17},1: CopyVar stat.RegEqn,f1: stat.results

The Scratchpad then displays the stat.results variables.

Scratchpad — 18

o L

[ vTiten "Linsar Fegression {mz+b)" fa

3.

2.
1.
1.

| "Resid" ")

)

1/99

Note: You can copy values from the stat.results variables and paste them
into the entry line.
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Viewing the History
Each evaluated expression and result becomes part of the Scratchpad history,
displayed above the entry line.

> Press a or w to scroll through the history.

o
0.537143 O

-7
¢

& F6012

1.7601186104112+2%

© Current entry/total entries

Copying a History Item to the Entry Line
You can quickly copy an expression, subexpression, or result from the history

into the entry line.

1. Press a or w to move through the history and select the item that you want
to copy.

2. Optionally, select part of the expression or result by using in
combination with the arrow keys.

73.1428571429

approx

3. Press to copy the selection and insertitinto the entry line.

581 16- /14
42 7
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Clearing the History

When you clear the history, all variables and functions defined in the history
retain their current values. If you clear the history by mistake, use the undo
feature.

» From the Actions menu, click Clear History.
Press (1] (5].

All expressions and results are removed from the history.

Editing Scratchpad Expressions

Although you cannot edit a Scratchpad Calculate expression in the history, you
can copy all or part of an expression from the history and paste it to the entry
line. You can then edit the entry line.

Inserting Elements into the Entry Line
1. Press [tab], ¢, ), 4, Or w to position the cursor in the expression.

The cursor moves to the closest valid position in the direction that you
press.

2. Type the elements or insert them from the Catalog.

Selecting Part of an Expression
You can delete, cut, or copy a selected part of an expression.
1. Press ¢, p, a, 0r w to move the cursor to a starting pointin the expression.
2. Press and hold and press ¢, p, a, Or w to select.
- Todelete the selection, press [%'].
- To cutthe selection to the Clipboard, press [ctn] [X].
- To copy the selection to the Clipboard, press [«r] [C].
- To paste the selection to a new entry line in Scratchpad, press (] [V].

Graphing with the Scratchpad

1. Press to open the Scratchpad Graph page ifitis not already open.
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By default, the entry line is displayed. The entry line displays the required
format for typing a relation. The default graph type is Function, so the form
f1(x)=is displayed.
If the entry line is not shown, press Ctrl + G or press to display
the entry line and type an expression to graph.

2. Press > Graph Entry/Edit and select a graph type.
For example:

«  To graph an equation for a circle, press > Graph Entry/Edit >
Equation > Circle > (x-h)2 + (y-k)2 = rZ or press (3) (2] (3] (1]. Fill
in the equation and press to draw the circle.

«  Tograph a function, press > Graph Entry/Edit > Function or press
B3] 0.

The entry line changes to display the expression format for the specified
graph type. You can specify multiple relations of each graph type.

3. Type an expression and any other parameters required for the graph type.

f?(x)=x2 +2*I‘ ;‘

4. Press to graph the relation, or press w to add another relation. If
necessary, you can use press to choose a tool on the
Window/Zoom menu and adjust the viewing area.

When you graph the relation, the entry line disappears to show an
uncluttered view of the graph. If you select or trace a plot, the relation that
defines the plotis displayed on the entry line. You can modify a plot by
defining a relation or by selecting and changing the graph.

As you graph multiple plots, the defining relation is displayed for each. You
can define and graph a maximum of 99 relations of each type.

5. Usethe key to explore and analyze the relation to:
+  Trace the relation.
»  Find points of interest.

* Assign a variable in the expression to a slider.

Viewing the Table
» Todisplay a table of values corresponding to the current plots, press >

Table > Split-screen Table ([meny] (7] [1]).
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» To hide the table, click the graph side of the split screen, and then press
> Table > Remove Table ([meny] 7] [2]). You can also press Ctrl + T.
» To resize columns, click the table and press > Actions > Resize
(frend] (3] (]).
» To delete a column, edit an expression, or edit table settings, click the table

and press > Table ([menu](2]).

Changing the Appearance of the Axes

As you work with graphs, the Cartesian axes are displayed by default. You can
change the appearance of the axes in the following ways:

1. Press (4] and choose the Zoom tool to use.
2. Selectthe axes and press (et ] to activate the Attributes tool.

a) Press a or w to move to the attribute to change. For example, choose
the end style attribute.

b) Press qor) to choose the style to apply.

c) Change any other attributes of the axes as required for your work, and
then press to exit the attributes tool.

3. Adjust the axes scale and tic mark spacing manually.

a) Click and hold one tick mark, and move it on the axis. The spacing
and number of tic marks increases (or decreases) on both axes.

b) To adjustthe scale and tic mark spacing on a single axis, press and
hold [eshift), and then grab and drag a tic mark on that axis.

4. Change axis end values by double-clicking them and typing new values.
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5. Adjustthe location of the axes. To move the existing axes without resizing
or rescaling them, click in and drag an empty region of the screen until the
axes are in the desired location.

6. Change the axes’ scales by pressing > Window/Zoom > Window
Settings ([meny] (4] [1)).

Type the values of your choice over the current values for x-min, x-max, y-
min, y-max, Xscale, and Yscale and click OK.

7. Press > View > Hide Axes ([menu] (2] (1]) to hide or show the axes.
+ Ifthe axes are shown on the page, selecting this tool hides them.

» Ifthe axes are hidden on the page, selecting this tool redisplays them.

Tracing a Plot
Graph Trace moves through the points of a graphed function, parametric, polar,
sequence, or scatter plot. To enable the trace tool:

1. Press > Trace > Graph Trace ([meny] (5] [1]) to move across the plotin
Trace mode.

Scratchpad <~

427y

2. (Optional) To change the trace step increment for tracing, press
(5] (3.

After you type a different step increment, the Graph Trace tool moves
across the graph in steps of that size.

3. Use Graph Trace to explore a plotin the following ways:
* Move to a pointand hover to move the trace cursor to that point.

*  Press qor) to move from point to point on the function’s graph. The
coordinates of each point traced are displayed.

32 Using the Scratchpad



Press a or w to move from one plot to another. The point's
coordinates update to reflect the new location of the trace. The trace
cursor is positioned on the point of the new graph or plot with the
closest x value to the last point identified on the previously traced
function or graph.

Type a number and press to move the trace cursor to the pointon
the plot with independent coordinates nearest the typed value.

Create a persistent point that remains on the graph by pressing
when the trace point reaches the point you want to label. The point
remains after you exit Graph Trace mode.

Notes:

The string undefis displayed instead of a value when you move over
a point that is not defined for the function (a discontinuity).

When you trace beyond the initially visible graph, the screen pans to
show the area being traced.

Press or choose another tool to exit Graph Trace.

Finding Points of Interest

You can use the tools on the Analyze Graph menu to find a point of interestin a
specified range of any graphed function. Choose a tool to find zero, the
minimum or maximum, the point of intersection or inflection, or the numeric
derivative (dy/dx) or Integral on the graph.

Select the point of interest that you want to find on the Analyze Graph

menu. For example, to find a zero, press (6] (1].

non-CAS| CAS

Zero (menu] (6] (1] | [meny] (6] (1]

Minimum (6] 2] (6]

Maximum (6] (6] (3]

Intersection (6] (4] (6] (4]

Inflection Not applicable (6]
dy/dx (6] (6] (6]
Integral (6] (6] (6]

Analyze Conics (6) (6]
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The icon for the selected tool is displayed at the top left on the work area.
Point to the icon to view a tooltip about how to use the selected tool.

Click the graph you want to search for the point of interest, and then click a
second time to indicate where to start the search for the point.

The second click marks the lower bound of the search region and a dotted
line is displayed.

Note: If you are finding the derivative (dy/dx), click the graph at the point
(numeric value) to use for finding the derivative.

Press ¢ or ) to move the dotted line that marks the search region, and then
click the point at which you want to stop the search (upper bound of the
search region).

Scratchpad =

i 7 30

Press at the point to start the search. The tool shades the range.

If the search region you specified includes the point of interest, a label for
the pointis displayed. If you change a graph that has points of interest
identified, be sure to check for changes in points of interest. For example, if
you edit the function on the entry line or manipulate a plot, the point where
the graph intersects zero can change.

The labeled points of interest remain visible on the graph. You can exit the
tool by pressing or choosing another tool.

Working with Variables in the Scratchpad

Scratchpad variables are shared between Scratchpad Calculate and
Scratchpad Graph, but not with any TI-Nspire™ documents. If you use the same
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name for a Scratchpad variable and a variable in a document, no conflict
occurs unless you attempt to copy expressions between documents and the
Scratchpad.

Saving the Scratchpad Contents

You can save the Scratchpad Calculate page, the Scratchpad Graph page, or
both as a TI-Nspire™ document.

1. Press [docv], and then select Save to Document ([doc+] [A]).
2. Press [enter].

The Save to Document dialog box opens.

to Document. ..

| Select Scratchpad contents
| to save to a document:
Calculate

Graph

Save to:

() New Document

(®) Current Document

Select the page or pages to save.
If a document is open, select either New or Current document.
Click Save.

+ Ifyou selected to save to a current (open) document, the Scratchpad
pages are added to the document.

+ Ifyou selected to save the Scratchpad pages to a new document, the
pages are converted to an unsaved document. To save the document:

- Press > Save. The Save As dialog box opens.
- Type a name for the document.

- Select Save to save the new document.
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Clearing Scratchpad Contents

Complete the following steps to delete the calculations and graphing work from
the Scratchpad application.

1. Press > Clear Scratchpad ([doc+] [B)).
2. Press to delete the Scratchpad contents.
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Working with Documents on TI-Nspire™
Handhelds

All of the work you do with a TI-Nspire™ handheld is contained in one or more
TI-Nspire™ documents, which you can share with other handheld users and
with those using the computer software.

Each document is divided into at least one, and up to 30, problems.
Each problem contains at least one, and up to 50, pages.
Each page can be divided into as many as four work areas.

Each work area can contain any of the TI-Nspire™ applications (Calculator,
Graph, Geometry, Lists & Spreadsheet, Data & Statistics, Notes, and
Vernier DataQuest™).

Opening a Document

1.

From the Home screen, select My Documents.
Press [2].

The file manager opens.

*Unsaved Document

B\ ) =
= Wy Documents 476K
5 Algebra | 19K
= Examples 306K
[# folder 1 0K
[ Folder 0K
ﬁmy newy folder 0K

i

B myLib 63K

Navigate to the file you want to open.

+  Press w to highlight the document name, and then press 3] or
to open the document.

. If the file is in a folder, press w to highlight the folder, and then press

or [enter]to open the folder.
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3. Press to open the Documents menu to access options for working
with the open document.

Creating a New Document

1. From the Home screen, select New Document.
—or—
Press (1].
You can also press [tr] [N].

A new document opens with a list of applications.

= 1:Add Calculator

i 2:Add Graphs

M 3:Add Geometry

s |4 Add Lists & Spreadsheet

15:Add Data & Statistics
5:.Add Notes

sy Add Vernier DataQuest

Note: The tab at the top left of the screen indicates that this is the first page
of the first problem.

2. Use w and a to highlight the application you want to add to the page, and
then press to open the page.

Saving Documents

To save the document in the My Documents folder:
1. Press to open the Documents menu, and then select File > Save.
Note: You can also press (1] (4] or [«tn] [S] to save a document.

The Save As dialog box opens.
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Save I | Wy Documents | = =

Marme Tvpe Size
[ MtyLib Folder A
[/ Examples Folder
| | [/ Transfers-9-29-10 Folder 1
- _@Foldeﬂ Folder =

File Mame: |Document1 |

]

If you are saving the document for the first time, you will be asked which
folder to save it to, and what to name the document. The default folder is
My Documents.

Type a name for the document.

Click Save to save the document in the My Documents folder.

Saving a Document in a Different Folder

To save the document in a different folder:

1.

3
4.
5
6

From an open document, press (] (5.
The Save As dialog box opens.

Press to navigate to the list of existing folders. The first folder in
the listis selected.

Use the w and a to scroll through the list of folders.
To select and open a folder, press .
Type a name for the document.

Click Save to save the document in the selected folder.

Saving a Document in a New Folder
To save the document in a new folder:

1.

From an open document, press (] (5].

The Save As dialog box opens.
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M Sanvé InC | Exaengles I 5 E]

Hamg Type Size

Getting Started 3_0 Diocument 120
B [ bese2 Dacurment 2K
s @ Typenewfoldername
W rite Hame |I:Ei."_" B‘

Sane | Cancel

2. Press until the New Folder icon is highlighted, and then press to
create a new folder.

The new folder is added to the bottom of the list of existing folders. By
default, the folder name is “Folder1.”

Type a name for the new folder, and then press to save.
4. Press again to open the folder.

The File Name field becomes active.
5. Type a name for the document.

6. Click Save to save the documentin the new folder.

Working with Applications

Options for working with applications include:
+  Creating a new document and selecting an application
* Adding a new page and application to an open document

* Adding multiple applications to a page in a document

Adding an Application
There are multiple ways to add an application to a page:

*  When creating a new document, use the Touchpad or corresponding
numbers to select an application from the list of applications.

+ To add a new page and application to an open document, press
and then select an application from the list.

For example, press (2] to add the Graph application to the page. The
application opens in the work area.
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You can also press [@ten], and then select an application from the Home screen
by clicking one of the following application icons:

Calculator
ﬁ Graphs
Geometry

Lists & Spreadsheet

Data & Statistics

Notes

Vernier DataQuest™

= v

Using Multiple Applications on a Page
You can add up to four applications to each page.
When you create a new document, it contains space to add one application. If

you need to add more than one application to a page, you can change the
layout to accommodate as many as four applications.
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You can choose a standard layout, provided as a menu item, or you can
customize a layout to suit your needs.

Choosing a Standard Page Layout

1.

2,

Press (5] (2] to display layout options.

Documents

: Customn Split

! Select Layout »
c Select App (Crl+K)
» Swap Applications

: Delete Application

: Delete Page

: Group (Ctrl+y
s Ungroup (Ctri+&)

[ 1: Layout 1
[ ut 2
H3: Layout 3
{0 |4 Layout 4
5 Layout 5
Hl&: Layout &
[B7: Layout 7
il g Layout &

00 |00 0 Fm G R —

Press the number that corresponds to the layout you want.

For example, press 2] to create a two-pane layout, divided vertically on
the page.

% Fress menu
10 H ia

Press (otr ] to move between panes. Bold lines around the pane
indicate that the pane is active.

Press [mend], and then press the number of the application you want to add
the new pane. For example, press (4] to add the Lists & Spreadsheet
application.
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Note: If you need to change the layout of the page to add or delete
applications, you can do so at any time. When deleting an application,
select the application to be deleted first.

Creating a Custom Page Layout
If the standard layouts do not meet your needs, you can customize the space
allotted to applications on a page.

1. Press (5] to display layout options.

Uy {063
Documents
1: File »
20 Edit e P, '[:Zl“t
3Wiew |5 Select Layout 3
4 Insert |3 Select App  (CHrI+K)
BT SuRAgS L 1. sivap Applications
& Refres|s: Delete Application
7. Sefting|s: Delete Page
8 Login.. 7. Sroup (Ctrl+y
Filx)o [ 3 Pressto Ungroup (Ctrl+5)

2. Press (1] to select the custom split option.

The standard layout is displayed with a divider between the application

panes. Use the arrows (if-'-r«"') in the middle of the divider to adjust the size of
the panes.
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3. Press a, w, ¢ or) to move the divider to adjust the height or width of the
panes in the layout.

4. Press [+ or =] to select a defined layout:
+  Pressing (=] returns to a full page layout.
+ Pressing once switches layout from a vertical layout to a horizontal
layout. Press (=] to go back to a vertical layout.

* Pressing twice adds a third pane to the page. Pressing multiple
times enables you to choose between a vertical and horizontal page
layout with three panes.

* Pressing five times adds a fourth pane to the page. Press (-] to
cycle through the previous layout options.
5. Press (%] or to accept the layout dimensions.

6. Press [ctn] to move between panes. Bold lines around the pane
indicate that the pane is active.

Swapping Applications on a Page
If you want to change the position of applications on a page with multiple
applications, you can do so by “swapping® the positions of two applications.

1. Press (5] Page Layout (4] Swap Application.
The selected application is surrounded by a heavy, flashing black border,
and the Swap App cursor £J is displayed on the screen.

Note: On a two-pane page layout, the selected application automatically
swaps position with the opposite pane. Press or to complete the
swap.
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2. Press a, w, ¢ or) to position the cursor over the application you are
targeting to swap.

3. Press or to complete the swap.
Note: Press to cancel the swap.
Grouping Applications
To group up to four application pages into a single page:
1. Select the first page in the series.
2. From the Document menu, select Page Layout > Group.

Press (5] (7].

The next page is grouped with the first page. The page layout
automatically adjusts to display all the pages in the group.
Ungrouping Pages
To ungroup the pages:
1. Selectthe grouped page.
2. From the Document menu, select Page Layout > Ungroup.
—or—
Press (5] (8].

The material becomes individual pages for each application.

Deleting an Application from a Page

1. Click the application you want to delete.

2. From the Document menu, select Page Layout > Delete Application.
—or—
Press (5] (5].
The selected application is deleted.

If you want to undo the delete, press Ctrl-Z.

Using the Application Menu

The Application menu enables you to select tools for working with a specific
application. Each application has a unique menu.
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Using the Application Menu
1. From a blank page, press to display the Application menu.

The menu displays applications that you can add to the page.

:7:Add Wernier DataQuest

2. Press the number of the application you want to add to the page. For
example, press [4] to add the Lists & Spreadsheet application.

3. Press to display the Application menu, which lists the options for
working with the current application.

The example below displays the Application menu for the Lists &
Spreadsheet application.

1 Actions B *Unsaved =
12 Insert »
1353 Data »
% 4 Statistics p
=5 Table »

a1 | [4]»

Context Menus

Context menus display options that are specific to the selected object or the
current cursor location.

Using the Context Menu

» To access a context-sensitive menu from an application, press [ctr] [menu] .
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In the example below, the context menu displays options available for the
selected cell in Lists & Spreadsheet.

Working with Problems and Pages

The options on the Documents menu let you:
. Save a document
» Access edit functions such as undo, redo, cut, copy, paste, and delete

*+ Move between pages and open the page sorter view for documents with
multiple pages

* Modify page layout, insert pages or problems, delete pages, and change
settings

+ Add problems, pages, and applications to open documents

»  Access page layout options

Adding a Problem to a Document

Adding problems to a document enables you to reuse variable names. A
document can contain as many as 30 problems. To add a new problem:

1. Press (4] (1] to open the Insert options.
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2. Page (Ctrl+y
3 Calculator

4 Graphs

5 Geometry

£ Lists & Spreadsheet

7. Data & Statistics

2 Motes

9 Wernier DataQuest

A Program Editor »
E: Sensor Console  (Ctrl+0))

L R AR R e
DN D OS5 =mm

B

A new problem with one page is added to the document. The tab at the top
left of the screen indicates that this is the first page of the second problem.

Press Menu

2. Press to open the Application menu, and then, press the humber
corresponding to the application you want to add to the new page.

Viewing and Reordering Pages in a Document

The Page Sorter displays all of the problems in your document and all pages
within each problem in thumbnail format. You can use the Page Sorter to
rearrange and delete pages, copy a page from one problem and paste itinto
another, and apply templates to pages.

Viewing Multiple Pages with the Page Sorter

Although the handheld typically displays the pages in your document one ata
time, the Page Sorter lets you see all of the problems in your document and all
pages within each problem in thumbnail format. You can use the Page Sorter
to rearrange and delete pages, and copy a page from one problem and paste it
in another.
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Opening the Page Sorter from a Document
» Press o] a.

The Page Sorter screen displays all of the problems and pages in the
current document.

FProblem 1 KN

FProblermn 2 [

T T T

Reordering Pages in a Problem

Use the Page Sorter (press [tn] a) to move a page within a problem with
multiple pages:

1. Pressthe qor) key to select the page you want to move.

A heavy border around the page indicates that itis selected.

Jocument

FProblem 1 (N

Problem 2 BN

2. Either press and hold or press [ctr] until the grab cursor Xy is
displayed.

Press ¢, p, a, or w to move the page to the desired position.
4. Press|%]or to finish the move.
Note: You can press to cancel.
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The page moves to the new location within the problem, and the counter
adjusts accordingly.

Copying a Page to Another Problem
To copy a page from one problem to another in the same document:

1.
2.

Press (] a to open Page Sorter.
Press ¢, p, a, or w to select the page you want to copy.

A heavy border around the page indicates that itis selected.

Document
T Fraoblem 1 KN
“Problermn 2 [EX

Press [«r] [C] to copy the page.

Press ¢, p, a, or w to select the desired position in the problem where you
will paste the page. The copied page will be placed after the page you
select.

Press (<] (V] to paste the page in the new location.

The page is copied to the new location within the problem, and the counter
adjusts accordingly.

Note: If the page contains variables with the same names as the new problem,
a conflict may occur. Rename the variables if necessary.

Copying a Page to Another Document
To copy a page from one document to another document:

1.

Press (] a to open the Page Sorter.

2. Press ¢, ), a, or w to select the page you want to copy.

A heavy border around the page indicates that itis selected.
3. Press [«n] [C] to copy the page.
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11.

Press to open My Documents.

Press a and w to highlight the folder containing the document you want to
copy the page to.

Press ) to open the folder.

—or—

Press (3].

Press the a and w keys to highlight the document.
Press or to open the document.

Press [«r] a to display the Page Sorter.

. Press ¢, p, a, or w to move the page to the desired position in the

document.
Press [etr] (V] to paste the page in the new location.

The page moves to the new location within the problem, and the counter
adjusts accordingly.

Copying, Pasting, and Deleting Problems

You can copy and paste a single problem from one location to another within
the same document or a different document. You can also delete a problem
from the document.

Copying and Pasting a Problem
To copy and paste a problem:

1.

Open the Page Sorter.

Press [ctn] a.

Press 3).
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Document

¥ Problem 1 (KN

¥ Problem 2 (2

Select the problem. If there are multiple problems, you can press
to collapse the Page Sorter to list the problems by number and title only.

Press [«n] [C].

Go to the location where you want the problem to appear.

Press [ctn] [V].

A duplicate problem is placed in the new location.

Deleting a Problem
To delete a problem from the document:

1.

Select the problem from the Page Sorter.

2. Press [en] [X].
The problem is deleted from the document.
Renaming a Problem

To rename a problem:

1.

o & DN

With the document active, open the Page Sorter.

Press [cti] a.

Select the problem name.

Press [ctn] menu],

Select (7] Rename and type the name.
Press [et] [S] to save the change.
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Adding a Page to a Problem

Each problem can contain up to 50 pages. To add a new page to a problem:

>

>

Press [ctr] or [en] (1] to add a blank page and select an application.
Press to display the Home screen, and then point to the application
you would like to add to the new page and click or tap.

A new page is added to the current problem.

Time Bazed

Rate: To displ

P o display a meter, connect
Duration: a sensor or select ShowHide
40z

heter from the Options menu.

B O

Note: The tab at the top left of the screen indicates that this is the second
page of the second problem.

Moving Through Pages in a Document

Tabs display up to three multiple pages. When a document contains more than
three pages, arrows appear on the left and right of the tabs.

Use the following keys to navigate through your documents.

(tn] ¢ displays the previous page.
(etn] p displays the next page.

(] a displays the Page Sorter.
(] w displays the previous view.

Use the Touchpad to click on the arrows that appear on either side of the
tabs to show additional pages in a document containing more than three
pages.
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Managing Documents

My Documents is a file manager in which you store and organize your
documents. The example below illustrates the My Documents screen with its
main parts labeled. Following the screen, you can find descriptions of each
labeled part.

4
*Unsaved Document S
Name ol Size |
[# Unsaved Document A !
o— = My Docurnents 844K —@
[ Backups oK
= Calculator 10K
@ [T Dacurnent 2K
I Documentz 7K
[0 Docurnent 3K
97 [® Circles_Equation_of_a_Circle... 16K o

© Expanded folder

@ Current, unsaved document
© Collapsed folder

@ System status indicators

@ File size

Browsing Files in My Documents
To open My Documents:
» Press (2].
Note: If you are working in a page, press [cn] a [ctr] a.

The My Documents screen opens, displaying all folders and files on the
handheld.
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*Unsaved Docurment R
Name ol Size

| Unsaved Document i
[ My Documents 844K
(7 Backups 0K
[ Calculator 10K
[0 Document? 2K
[ Document2 7K
[ Document3 3K

[ Circles_Equation_of_a_Circle.... 16K g

»  To sort columns by name or size, click that column head. Click again
to change the sort from ascending to descending.

* To scroll through My Documents, click or grab the scroll bar.

+ To expand a single folder, point to the folder and click on the folder
icon or press (<] ). To collapse, click again or press [cr] 4.

+  To expand all folders, press (7). To collapse, press (8].

Renaming Folders or Documents
To rename a folder or document:

1. Pressthe a and w keys to highlight the document or folder you want to

rename.
2. Press (2].
*Unsaved Docurnent |
Name a| Size
Unsaved Document a2
[ My Documents 844KI
(7% Backups 0K
[ Calculator 10K
[ [J Documentt 2K|
[ Document2 7K
[ Document3 3K
[ Circles_Equation_of_a_Circle.... 16K g

The document or folder name is highlighted.
3. Type a new name and press to complete the change.
Note: Press to cancel.
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Creating Folders
You can create folders two different ways:

*  You can create a folder when you save a new document: The Save and
Save As menu commands allow you to enter a new folder name for the
document.

*  You can create a folder directly from the My Documents screen. Press

(1]. Type a name for new folder, and press [%] or to add it.

File and Folder Naming Conventions
Folder names must be unique. File and folder names can be very long, and
can include almost all characters, including spaces and punctuation.

Note: If you are planning to transfer these documents to your computer for use
in the TI-Nspire™ software, it is best to use names that are accepted on your
computer. Avoid punctuation, \, /, or symbols.

Deleting Documents and Folders

1. Press a and w to highlight the document or folder you want to delete.
2. Press [en] (6].

—or—

Press [&'].

*Unsaved Docurnert f

Name gy

Unsaved Document

[= My Documents 3 Cut
[ Backups 4:Copy
% Cal
2 Calculator 6:Delete
[ Document1 R
‘Rename
[ [ Docurnent2 &:New Document
[ Document3 9:New Folder
[7 Circles_Equation_of_a_Circle.... ‘ 16K‘|_
el

.

A dialog box opens, confirming that you want to delete the file or folder.
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*Unsaved Docurnent S8

Name ol Size
Unsaved Document 2
B Confitrn Docurnent Delete UK I
75| Do you really want to delete document DK
= ‘Document2? K
I |Cancel| 2K
| — 7K
[ Document3 3K
[/ Circles_Equation_of_a_Circle... 16K|L
N v

3. Press|[%]or to select Yes.

The document is deleted.
Duplicating Documents and Folders
Use Copy [tr] [€] and Paste [«t] [V] to duplicate documents and folders.
To copy a document to another folder, select the desired folder, and then paste.

Recovering Deleted Documents

Most operations performed in My Documents can be undone. Press (et (Z]
(Undo) to cancel the last operation until the deleted document is restored.

Closing a Document
1. To close a document, press (1] [3].
Press [cr] [W)].

If you have changed the document, you will be asked whether you want to
save those changes.

2. Click Yes to save the document or click No to abandon the changes.

Understanding the TI-Nspire™ Tools

This section provides an overview of the tools used when working with
TI-Nspire™ documents on a handheld, including variables, catalog, symbols,
and math templates.
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Creating TI-Nspire™ Variables

Variables can be any portion or attribute of an object or function created within
an application. Examples of attributes that can become variables are the area
of a rectangle, the radius of a circle, the value contained in a spreadsheet cell
or the contents of a column, or a function expression. When you create a
variable, it is stored in memory within the problem. You will find more
information about variables in the chapter titted Using Variables.

Using the Catalog

Use the catalog to access a list of TI-Nspire™ commands and functions, units,
symbols and expression templates. Commands and functions are listed
alphabetically. Commands or functions not beginning with a letter are found at
the end of the list (&, /, +, -, and so on). To open the catalog:

1. From an open document, press to open the catalog.

1.1 | Unsaved 7 @B

interpolate( ™
A dd°*mm’ss.ss”
integral(Expr, Var[, Lower, Upper]) 3

2. Pressthe number key corresponding to the appropriate tab.
For example, press (2] to show a list of math functions.
3. Press v until the item you want to insert is highlighted.

A syntax example for the selected item is displayed at the bottom of the
screen.

Note: To see additional syntax examples of the selected item, press [tab],
and then press to maximize or minimize the Help. To move back to

the selected item, press (tab].
4. Press to insert the item.
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About the Catalog Window

The catalog window uses these tabs to categorize commands, special
characters, and templates in documents:

1: g2 | Contains all commands and functions, in alphabetical order

Contains all math functions

3.« | Provides a symbol palette for adding special characters

4 oft Contains math templates for creating two dimensional objects,
including product, sum, square root, and integral

|5; iiil | Shows public library (LibPub) objects

CAS:

163 Contains all commands and functions, in alphabetical order

Contains all math functions

Provides the values for standard measurement units
4 .E;-l Provides a symbol palette for adding special characters

5.2 | Contains math templates for creating two dimensional objects,
including product, sum, square root, and integral

Shows public library (LibPub) objects.

Using Wizards

Some catalog functions have a wizard to help you enter function arguments. To
use a wizard, press until the Wizards On box is highlighted. Press

or to select the check box.
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1: 2z J2 |3 =g | 42| 5 bl N
List 2
=] Matrix
Create
Transpose
Determinant
Row-Echelon Farm il
List =
/95 |

Entering Special Characters

The symbol palette contains a subset of the objects found in the catalog. To
open the symbol palette:

1. Inan open document, press [ctn] ().

1.1| *nsaved = “”Q-DB
el il e|~|B _ ° |
5 Y T R e oy -1 E‘n
B x|/ —l"‘li'v
| 0!99|

2. Press ¢ ), a,0r w to selecta symbol.
3. Press to insert the symbol.

Entering Math Expressions

Use math expression templates to create two-dimensional objects such as
summation, integral, derivative, and square root. To open the math expressions
palette:

1. Inan open document, press [v].
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1.1 | *nsaved - @

o |0 |0[3E]e” | | b {88 5 |
lof | oo |[38]| e

g [ T840 | Taao | imo
350 |[Ben | foan | Img

| 0/99 |

2. Press ¢, ), a, 0r w to select an expression.
3. Press[%]or to insert the expression.

Entering International Language Characters

Use the (B) key to enter specially accented or punctuated characters in
applications such as Notes that allow text input.

1. Open an application such as Notes that allows text input.

2. Type the desired text.

3. Position the cursor after the letter that you want to accent. For example, “e”
while in the French locale.

4. Press (B on the keypad. Notice that the “e" changes to “é.“ Keep pressing
@ until you find the accented version of e that you want. Press [ ] or the
next letter of your text to accept the character and continue typing.
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Working with Images

Images can be used in TI-Nspire™ applications for reference, assessment, and
instructional purposes. You can add images to the following TI-Nspire™
applications:

* Graphs & Geometry

+ Data & Statistics

* Notes

. Question, including Quick Poll

In the Graphs & Geometry and Data & Statistics applications, images are setin
the background behind the axis and other objects. In the Notes and Question
applications, the image is set at the cursor location inline with the text (in the
foreground).

You can insert the following image file types: .jpg, .png, or .bmp.

Note: The transparency feature of a .png file type is not supported. Transparent
backgrounds are displayed as white.

Working with Images on a Handheld

On a handheld, images can be copied from one document to another or
resized or repositioned within a document. You can also delete images from a
document.

You cannot add or insertimages into a document when working on a
handheld. However, you can transfer a document containing an image from
your computer to a handheld. If using a TI-Nspire™ CX handheld, colors are
retained. If transferred to a TI-Nspire™ handheld, the colors in the image are
converted to gray scale.

Note: If there is not enough memory on the handheld to accommodate a
document containing an image, an error message is displayed.
Copying an Image

Complete the following steps to copy an image from one document to another
or from one page to another within the same document.

1. Open the document that contains the image you want to copy.

2. Selectthe image.
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In the Question or Notes applications, move the cursor over the image

and press [3].
In the Graphs & Geometry application, press 1] (2] [2].
In the Data & Statistics application, press (6.

A border appears around the image.
Press (et ] [menu], and then click Copy. You can also press [en] [C].

4. Open the document where you want to paste the image or select a page in
the current document.

Note: If you open a new document, you will be prompted to save and close
the current document.

5. Press [en] [V].

Note: If pasting an image into the Graphs & Geometry application, press
enter], and then press [etn] V).

The image is copied to the page in the document.

Repositioning an Image
Complete the following steps to reposition an image on a page.

1. Open the document and navigate to the page that contains the image.

2. Selectthe image.

In the Question or Notes applications, move the cursor over the image,
and then press, hold, and release . The image appears shaded.

In the Graphs & Geometry application, press 1] 2] [2].
In the Data & Statistics application, press (6].

A border appears around the image.

3. Move the image.

In the Question or Notes applications, move the cursor to the new
location and press [3].

In the Graphs & Geometry or Data & Statistics applications:

- Pressand hold until the cursor changes to a four-sided arrow

( + ). The image floats in the background and the border
changes to a dashed line.
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- Move your finger over the Touchpad to move the image to the
new location, and then press or to place the image.

Resizing an Image
Complete the following steps to resize an image on a page.

1.
2,

6.

Open the document that contains the image.
Select the image.

* Inthe Question or Notes applications, or in Quick Poll, move the
cursor over the image and press, hold, and then release . The
image appears shaded.

+ Inthe Graphs & Geometry application, press 1] 2] [2].
+ Inthe Data & Statistics application, press (6].
A border appears around the image.

Move the cursor to one of the corners.

The cursor changes to a four-sided directional arrow ( :)F/: ).

Note: If you move the cursor to the edge of an image, the cursor changes to
a two-sided directional arrow. You can drag the image left or right to resize
it, but the image will become distorted.

Press [3].

The @ tool is enabled.

Move your finger over the Touchpad in any direction to resize the image.

A dashed line appears to indicate the new size.

To accept the new size, press (3] or [enter].

Deleting an Image
Complete the following steps to remove an image from a page.

1.
2.

Open the document that contains the image.
Select the image.

. In the Question or Notes applications, move the cursor over the image,
and then press, hold, and release . The image appears shaded.

+ Inthe Graphs & Geometry application, press (1] 2] (2.
» Inthe Data & Statistics application, press (6].
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A border appears around the image.
3. Press [ct] [menu], and then select Delete.
The image is removed.

Note: In the Question and Notes applications, you can also press to
remove a selected image.
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Working in a TI-Nspire™ Navigator™ Teacher
Software Classroom

If you are in a classroom where TI-Nspire™ Navigator™ Teacher Software is
used, you will need to log in to class to communicate with the teacher’s
computer. The teacher can communicate with your handheld in the following
ways:

+ Sendfiles

+ Collectfiles

+ Delete files

»  Send Quick Polls and receive Quick Poll responses

The teacher can also pause and restart your handheld. When class is paused,
you will receive a message on your handheld. You cannot use your handheld
until the teacher releases the handheld from pause mode.

Connecting to the TI-Nspire™ Navigator™ System

To connect to the TI-Nspire™ Navigator™ network, you must log in to the
network from your handheld. Before you can log in, the teacher must complete
the following tasks:

+  Starta class session on their computer.

. Provide you with the class network name, a username and, if necessary, a
password.

Note: Use this method to log in to the network if the operating system on the
handheld is version 3.2 or higher.

Logging in to the TI-Nspire™ Navigator™ Network

1. Ensure your TI-Nspire™ handheld is ready for login. (The 0 icon is
blinking.)

2. Attach a wireless adapter or wireless cradle to the handheld.
3. Complete one of the following actions:

+  From the Home screen, press [5] [5].

«  From an open document, press (8].
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The Login to Class dialog box opens and the last network that was
associated with the wireless client appears.

ft

Login to Class

0009371FOB08

User Name: [jgarcia

Password: |aaa

Note: If the handheld is connected to the computer with the USB cable, no
network names appear on the screen, and you can continue logging in.

4. Ifthe name of the network that appears is correct, click Login. If the network
is not correct, click Network.

The handheld screens displays the last network the wireless client was
attached to, and also displays other networks within range.

# D

Al Calculate 1 New Document
B GrlTI—Nspire Networks nents

0009371F0OB08

0009371F0B08

Refresh

5. Select the network from the list, and then click Connect.

The login screen shows the connection status and displays the network
name when the connection is successful.

6. Type your username and password.
7. SelectLogin.

The Login Successful screen opens.
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Login Successful

You are logged in as user: John

8. Click OK.

TI-Nspire™ Handheld Login Status Icons

The icons on the TI-Nspire™ CX, TI-Nspire™ CX CAS, TI-Nspire™, and
TI-Nspire™ CAS handheld screens indicate the communication status between
the handheld and the access point, wireless adapter, wireless cradle, or
TI-Navigator™ network. The icons indicate status as follows.

Icon | Status | Meaning

'53‘ Blinking | The handheld is searching for an access point.
E Solid The handheld has found an access point.
E\'.‘ Solid The handheld is not communicating with the adapter or

cradle. Remove the handheld from the adapter or
cradle, wait for the icon to disappear, and then reattach
the handheld to the adapter or cradle.

0 Blinking | The handheld is connected to the network and is ready
to login.

0 Solid The handheld is logged in to the network.

Understanding File Transfers

During a class session, the teacher can send files to student handhelds and
collect or delete files from student handhelds.

Note: Before class starts, teachers can set up actions to send or collect files.
When you log in, the files are sent or collected. If the teacher set up actions to
both send and collect files, you will only see the dialog box for the last action
completed.
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Opening Sent Files

When the teacher sends a file to your handheld, the Transfers Complete dialog
box opens.

Transfers complete

Allfiles hawve been transferred.

» Click Open to open the file. If the teacher sent multiple files, this opens the
lastfile in the list.

Note: The files are received alphabetically by name, no matter which order
the teacher sentthem in. The lastfile in the listis the last alphabetical file.

» Click Go To to go to the location on the handheld where the file was sent.
The file name is highlighted. You can open that file, or navigate to another
file. If the teacher sent multiple files, the last alphabetical file in the listis
highlighted.

» Click Cancel to dismiss the dialog box without opening the file. Your
handheld returns to the state it was in when the message was sent.

Collecting or Deleting Files

Your teacher may collect or delete files from your handheld during a class
session. For example, teachers can collect homework assignments or delete
certain files prior to a test. When the teacher collects or deletes files, you
receive a message on your handheld.

Transfers complete

All files hawe been transferred.

» Click Cancel to dismiss the message.
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Configuring Handhelds

This chapter provides information needed to:

. Maintain batteries used in the handheld.
+ Change the default settings.
*  Attach a wireless module when the handheld is used in the classroom.

Checking Battery Status

To check the status of the TI-Nspire™ Rechargeable Battery in a handheld:
1. Press [glon].

The Home screen opens.
2. Press (5] [4] (Settings > Status).

The Handheld Status dialog box opens.

Battery status is
shown here.

Verstom: 3.0.0. 1007

Avziable Spane 97 0 ME owr of 1152 ME

Mefwork, Wirsless oadle i not affached
Login: Naot logpad in

== &

3. Click OK or press to close the window.
Note: From an open document, press (4] ([docv) > Settings & Status >

Status).
Recharging the Handheld

To recharge the TI-Nspire™ Rechargeable Battery in a handheld, connectit to
any of the following power sources:

+ Astandard USB cable connected to a computer
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* ATIUSB wall charger (sold separately)
* ATI-Nspire™ CX Docking Station if in a classroom setting

The amount of time required to fully charge the battery may vary, but charging
normally takes about six hours. It is not necessary to remove the TI-Nspire™
Rechargeable Battery from the handheld to recharge it. The handheld operates
normally while itis attached to a charging source.

Recharging a Battery from a Computer

To recharge a handheld from a computer, a TI-Nspire™ USB driver must be
installed. USB drivers are standard with any TI-Nspire™ software, which
includes:

*  TI-Nspire™ Teacher Software

*  TI-Nspire™ CAS Teacher Software

*  TI-Nspire™ Student Software

»  TI-Nspire™ CAS Student Software

*  TI-Nspire™ Navigator™ Teacher Software

*  TI-Nspire™ CAS Navigator™ Teacher Software

To download software thatincludes a driver, go to education.ti.com/software.

Understanding the Priority of Power Sources

When the TI-Nspire™ Rechargeable Battery is fully charged, the handheld
draws power in the following order:

. First, from a connected external power source, such as:
- Acomputer connected through a standard USB cable
- An approved wall charger (sold separately)

+ Second, from the TI-Nspire™ Rechargeable Battery

Disposing of Used Batteries Safely and Properly
Do not mutilate, puncture or dispose of batteries in fire. The batteries can burst

or explode, releasing hazardous chemicals. Discard used batteries according
to local regulations.

Changing Handheld Settings

Use the options on the Settings menu to change or view the following settings:

+ Change language
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Settings (Document and Graphs & Geometry)

- Define or restore settings for open documents and the Scratchpad
- Define or restore default settings for the handheld

Handheld Setup

Status

Login

Note: Not all options are accessible at all times. Options that are unavailable
are disabled.

Opening the Settings Menu

| 4

From the Home screen, press [5]or use the Touchpad to select Settings.

The Settings menu opens.

ft ]
& Scratchpad E Documents
Calculate BB Hew Cocument

My Documents

Changing a Preferred Language

Complete the following steps to change a preferred language:

1.
2.

From the Home screen, press (5] or select Settings to open the menu.
From the menu, select Change Language or press (1].

The Change Language dialog box opens.
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4

Scratchpad Dacuments
N Calculate Bl Hew Document

(B [ Change Language. ..

Language: | English (J.35) |

Ok | | Cancel

e Bl D ) S LD =

Press p to open the drop-down list.
4. Press w to highlight a language, then press or to selectiit.

Press to highlight the OK button, and then press [§] or to save
the language selection.

Customizing the Handheld Setup

Handheld setup options enable you to customize options to suit your needs.
»  Fontsize (small, medium or large).
+ Power standby. (1, 3, 5, 10 or 30 minutes).

- Use this option to extend battery life.

- By default, the handheld automatically powers down after three
minutes of inactivity.

. Hibernate (1, 2, 3, 4, 5 days or never).
- Use this option to extend battery life.
- When hibernating, the handheld saves current work in memory.

- When you turn the handheld on again, the system reboots and opens
saved work.

* Pointer speed (slow, normal or fast).
*  Auto dim (30, 60 or 90 seconds, and two or five minutes).

+ Enable tapping to click.

Changing Handheld Setup Options
1. From the Home screen, press (5] (3] (Settings > Handheld Setup).

The Handheld Setup dialog box opens.
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Handheld Setup

Fant Size: | Medium

FPower Standhby:
Hihernate:
Pointer Speed: |

[] Enable tapping to click

Press until the desired category is highlighted.
Press ) to view the list of possible settings.
Press w to highlight the desired setting.

Press (2] or to select the new setting.

When you have changed all the settings to suit your needs, press until
OK is highlighted, then press %] or to apply your changes.

Note: Click Restore to return the handheld to the factory settings.

2 e o

Customizing Document Settings

Document settings control how the handheld displays and interprets
information in TI-Nspire™ documents and in Scratchpad. All numbers, including
elements of matrices and lists, are displayed according to the document
settings. You can change the default settings at anytime and you can also
specify settings for a particular document.

Document settings and their possible values are listed in the following table.

Field Values
Display Float
Digits Float1 - Float12
Fix0 - Fix12
Angle Radian
Degree
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Field Values
Gradian

Exponential | Normal

Format Scientific
Engineering

Real or Real

Complex Rectangular
Polar

Calculation | Auto

Mode CAS: Exact
Approximate
Note: Auto mode displays an answer thatis nota whole
number as a fraction except when a decimal is used in the
problem. Exact mode (CAS) displays an answer thatis nota
whole number as a fraction or in symbolic form, except when
a decimal is used in the problem.

Vector Rectangular

Format Cylindrical
Spherical

Base Decimal
Hex
Binary

Unit System | SI

(CAS) Eng/US

Changing Default Document Settings

Complete the following steps to define default document settings for TI-Nspire™
documents and Scratchpad.

1. Save and close any open documents.

2. From the Home screen, press (Settings > Document Settings).

The Document Settings dialog box opens.
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Note: If a document is open, the Document Settings dialog box also
contains an OK button. If you select OK, settings are only applied to the
open document.

Document S

Exponential Format: | Mormal
Feal or Complex:

Calculation Mode: | Auto

Display Digits: | Float & =
A it
E Angle: | Radian

1=

‘ector Format: | Rectanoular

|Rest0re| |Make Default" |Cancel|

3. Press to move through the list of settings. Press a to move backward
through the list.

A bold line around a box indicates itis active.

4. Press ) to open the drop-down list to view the values for each setting.
Press the a and w keys to highlight the desired option, then press
or to select the value.

6. Select Make Default.

The Apply and Save as Default dialog box opens.
ft

Document Settings

Angle | Radian ~

as Default

Apply your settings and sawve them as default
for new documents and Scratchpad?

1 |Rest0re| |Make Defaultl |Cancel| IJ

7. Click OK to save the settings as default settings that will be applied to all
TI-Nspire™ documents and to Scratchpad.
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Changing Document Settings in a TI-Nspire™ Document

Complete the following steps to change document settings for an open
TI-Nspire™ document. You can apply the settings to the current document only
or choose to make the settings the default settings for the open document and
all future documents.

1.

From an open document, press (5] (2] ([@Fen) > Settings > Document
Settings).

The Document Settings dialog box opens.

_‘ Document Settings

Display Digits: | Float &
Exponential Format:

Feal or Complesx:
Calculation Mode: | Auto

“ector Farmat: | Rectanaular ol

|Rest0re| |Make Defaultl |Cancel|

Press to move through the list of settings. Press a to move backward
through the list.

A bold line around a box indicates it is active.

When you reach the desired setting, press ) to open the drop-down list to
view values for each setting.

Press the a and ¥ keys to highlight the desired option, then press

or to select the value.

Click OK or press or to apply the new settings only to the open
document.

The Home screen opens and the new settings are only applied to the open
document.

To apply the new settings to the open document and to documents created
in the future:

+  Select Make Default and press [] or [enter].

+ Click OK to apply the settings to any open documents and save the
settings as defaults for new documents and for Scratchpad.
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Restoring Document Settings

Complete the following steps to restore the original factory settings to open or
new documents, and to the Scratchpad.

1. From the Home screen, press [5] [2] (Settings > Document Settings).
The Document Settings dialog box opens.
2. Use the Touchpad or press to select Restore, and then press [enter].

The Restore Defaults dialog box opens.

Documen

Restare settings to factory default settings?

[NEEE NN VETHTINETY il

|Rest0re| |Make Defaultl |Cancel|

3. Click OK to restore settings to the factory default settings.
4. PressOKor to return to the Home screen.

Customizing Graphs & Geometry Settings

Graphs & Geometry settings control how information is displayed in open
problems and in subsequent new problems. When you customize application
settings, your selections become the default settings for all of your work in the
Graphs and Geometry applications.

Complete the following steps to change the Graphs & Geometry Settings and
make these settings the default for all new graphs and geometry documents
and Scratchpad.

1. Open a document with the Graphs or Geometry application active.

2. Press (9] ([menu] > Settings).
The Graphs & Geometry Settings dialog box opens.
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Display Digits: | Float 3 =
Graphing Angle:
Geometry Angle:

] Automatically hide plot labels

Show axis end values

[ 1 Shawe tanl tine far functinn maninolation i

3. Press to move through the list of settings. Click p to open the drop-
down listto view the values for each setting.

Make Default

|Rest0re| Cancel|

Field Values
Display Digits  |Auto

Float

Float1 - Float12
Fix0 - Fix12

Graphing Angle | Auto

Radian
Degree
Gradian

Geometry Angle | Auto

Radian
Degree
Gradian

4. Press w to view the values, then press [2] or to select a value.

In the lower half of the dialog, select a checkbox to enable an option or
clear a checkbox to disable an option.

Checkbox Operation when selected

Automatically hide | Plotlabels display only when a plotis hovered,
plot labels selected or grabbed.
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Checkbox Operation when selected

Show axis end Displays a numeric label at the least and greatest
values values visible on an axis.

Show tool tips for Shows helpful information as you manipulate
function function graphs.
manipulation

Automatically find Shows zeros, minima and maxima for graphed
a point of interest functions and objects while tracing function
graphs.

6. Choose one of the following options:

+ To apply the customized settings to ALL graphs and geometry
documents, click Make Default. When the Apply and Save as Default
dialog box opens, click OK.

+ To apply the settings to the open document only, click OK.

. To restore default settings, click Restore. When the Restore Defaults
dialog box opens, click OK.

»  Click Cancel to close the dialog box without making changes.

Viewing Handheld Status

The Handheld Status screen provides the following information about the
current state of the handheld:

»  Battery status for the rechargeable batteries

»  Software version

* Available space

*  Network (ifany)

*  Yourstudentlogin name and whether you are logged in
* About

Opening the Handheld Status Screen
1. From the Home screen, press (5] (4] (Settings > Status).

The Handheld Status screen opens.
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| Handheld tus

Batteries: 5] 100% [0

Version: 3.0.0.1007

Availehle Spare: 97 0 ME ow! of 1152 ME

Network: Wirsless svadie is not aftachead.

Login: Not loggad in.
Ahout Ok,

2. Click OK to close the Handheld Status screen.

Viewing Handheld Details

The About screen provides additional information about the handheld type, the
operating system (OS) version and the product ID.

1. From the Home screen, press (5] (4] (Settings > Status).
The Handheld Status screen opens.

2. Click About to view details about the handheld.

>

Handheld Type: TI-Mspire™

Math and Science Learning Technologsy
Copyright @ 2006-2010 Texas Instruments
All rights resersed.

Product |0
OE10000B3594B10B830DE58FFI2E

ok

<

3. Click OK to close the About dialog box.

4. Click OK to return to the Home screen.

Replacing TI-Nspire™ Rechargeable Batteries

When you replace the battery, complete the following steps to insert the
TI-Nspire™ Rechargeable Battery into a handheld.
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1. Use a small screwdriver to release the panel from the back of the
handheld.

2.

3. Remove the old battery.

4. Insertthe white connector of the new battery into the jack located at the top
of the battery compartment.

5. Thread the wire into the case to secure it. Insert the rechargeable battery
into its compartment.
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Using Wireless Communication Hardware

Teachers using TI-Nspire™ Navigator™ Teacher Software in the classroom can
use TI-Nspire™ Navigator™ Cradles or TI-Nspire™ CX Wireless Network
Adapters along with the TI-Nspire™ Navigator™ Access Point to establish
wireless communication between TI-Nspire™ CX handhelds and their
computer. The network adapters can only be used with the TI-Nspire™ CX
handhelds.

Use the wireless cradle to establish a wireless connection between the teacher

computer and any TI-Nspire™ handheld.

Attaching a Wireless Adapter to a CX Handheld

The TI-Nspire™ CX Wireless Network Adapters work with the TI-Nspire™ CAS
and TI-Nspire™ CX CAS handhelds. The battery in the TI-Nspire™ CX handheld
powers the wireless adapter. To connect the handheld to the wireless adapter:

1. Position the wireless adapter on top of the handheld so the connector on
the adapter lines up with the connector on top of the handheld.

Wireless network adapter (school-owned)
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Guides foraligning
with handheld

Connector

2. Slide the adapter into position, making sure the guides on the sides of the
adapter slide into the grooves on the sides of the handheld.

Sideview of handheld

Groove to align (D
wireless adapter

3. Firmly press the adapter into place so that the adapter sits on top of the
handheld as shown in the following illustration.

Configuring Handhelds 85



Note: The TI-Nspire™ CX handheld can be charged with the wireless adapter
attached.

Attaching a Wireless Cradle to a Handheld

The TI-Nspire™ Navigator™ Cradles can be used with all TI-Nspire™ handhelds
to wirelessly connect to the teacher computer. To connect a handheld to a
cradle:

1. Slide the lock on the back of the cradle to the OFF position.
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2. To attach the handheld, face the screen upward and slide the handheld
onto the top of the TI-Nspire™ Navigator™ wireless cradle. Be sure that
both sides of the handheld are inserted into both of the side guides.

e

3. Press firmly to make a good connection. When properly connected, the
TI-Nspire™ handheld appears to be sitting on top of the cradle.

4. Lock the handheld in place by sliding the lock on the back of the cradle to
the ON position.
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Connecting Handhelds and Transferring Files

This chapter describes how to connect one TI-Nspire™ handheld to another,
how to connect handhelds to a computer, and how to transfer files between
them.

The TI-Nspire™ handhelds have a USB port that enables connectivity with
another TI-Nspire™ handheld or with a computer.

Note: When using the TI-Nspire™ TI-84 Plus keypad, you can connect with
another TI-Nspire™ handheld using the TI-Nspire™ TI-84 Plus keypad or a TI-84
Plus using the USB port or the 1/O port.

Connecting Handhelds
Using USB Cables

You can use USB cables to connect two TI-Nspire™ handhelds, to connect a
TI-Nspire™ handheld to a computer, or to connect one TI-Nspire™ handheld
using TI-Nspire™ TI-84 Plus keypad to another.

TI-Nspire™ USB connection cable to  TI-Nspire™ handheld mini-USB cable
connect handheld to a computer. to connect two TI-Nspire™ handhelds.

Connecting Two TI-Nspire™ Handhelds with the Mini-USB Cable

You can connect two handhelds as long as both handhelds are using the same
keypad. You cannot connect a handheld using the TI-Nspire™ TI-84 Plus
keypad to a handheld using the native TI-Nspire™ keypad.
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The TI-Nspire™ handheld USB port is
located in the center on the top of the
TI-Nspire™ handheld.

The USB port is located on the top of
the TI-Nspire™ CX handheld on the
right side when holding the handheld
with the screen facing you.

@ Portfor connecting a wireless adapter.

@ USB port on the CX handheld.

To connect the handhelds:

1. Firmly insert either end of the mini-USB cable into the USB port.

2. Insertthe other end of the cable into the receiving handhelds’s USB port.

Connecting the TI-Nspire™ Handheld to a Computer
1. Firmly insert the mini-USB end of the cable into the port at the top of your

handheld.
L 2/

2. Firmly insertthe USB end of the cable into the USB port of the computer.
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Transferring Files to and from Handhelds

You can send documents, Operating System (OS) files, and folders to another
TI-Nspire™ handheld.

Rules for Transferring Files and Folders

You can transfer documents and OS files.

Operating systems are not interchangeable between different handheld
types. For example, you cannot transfer a CAS operating system to a non-
CAS handheld.

If a document with the same name as the one you are sending already
exists on the receiving handheld, the document will be renamed. The
system appends a number to the name to make it unique. For example, if
Mydata existed on the receiving handheld, it would be renamed Mydata

2).
Both the sending and receiving handhelds will display a message that
shows the new name.

There is a 255-character maximum length for a file name, including the
entire path. If a transmitted file has the same name as an existing file on
the receiving handheld and the file names contain 255 characters, the
name of the transmitted file will be truncated to enable the software to
follow the renaming scheme described in the previous paragraph.

All variables associated with the document being transmitted are
transferred with the document.

Transmissions will time out after 30 seconds.

Caution: Some older TI-Nspire™ handhelds cannot receive folders; only files. If
you receive an error in sending to an older TI-Nspire™ handheld, see Common
error and notification messages.

Sending a Document or Folder to Another Handheld

1.
2.

Ensure the two handhelds are connected.

Open the My Documents file browser and navigate to the file or folder you
want to transfer.

Press the a and v keys on the Touchpad to highlight the document or
folder you want to send.

Press (1] (6] to select Send from the Documents menu.
TI-Nspire™ Handheld: Press IO}
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5. The file transfer begins. A progress bar shows the status of the transfer.
There is also a cancel button in the Sending... dialog box to enable you to
cancel the transmission while itis in progress.

At the end of a successful transmission, the message

“<Folder/ File name> transferred as <Folder / File name>.” is displayed. If
the file had to be renamed on the receiving handheld, the message will
show the new file name.

Receiving a Document or Folder
No action is required by the user of the receiving TI-Nspire™ handheld.
Handhelds are automatically powered on when the cable is attached.

At the end of a successful transmission, the message “<Folder / File name>
received.” is displayed. If the file had to be renamed, the message will show the
new file name.

Caution: Some older TI-Nspire™ handhelds cannot receive folders; only files. If
you receive an error in sending to an older TI-Nspire™ handheld, see Common
error and notification messages.

Canceling a Transfer

1. To cancel a transmission in progress, press Cancel on the sending
handheld. The user of either handheld can also press (TI-Nspire™
Handheld: Press (esc).)

2. Press or to cancel the transmission error message.

TI-Nspire™ Handheld: Press (esc) or (enter).

Transferring Files Between Computers and Handhelds

In the Documents Workspace, teachers and students can use the “drag and
drop” method to quickly transfer files and folders from a computer to a
handheld or transfer files from a handheld to a computer.

1. Connectthe handheld to the computer using a standard A to mini-B USB
cable.

2. Inthe TI-Nspire™ software, open the Documents Workspace.

3. Inthe Documents Toolbox, click - to open the Content Explorer.
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Computer panel

Connected Handhelds

Navigate to the folder that contains the file you want to transfer.

+ To transfer a file from a handheld to the computer, click the file, and
then drag the file to a folder in the Computer panel.

* To transfer a file from the computer to a handheld, click the file, and

then drag the file to a connected handheld.

Note: Those using the TI-Nspire™ Teacher Software or the TI-Nspire™
Navigator™ Teacher Software can also use options in the Content Workspace

to transfer files from a handheld to a computer.

Using the Save to Handheld Option

In the Documents Workspace, you can also use the Save to Handheld option
on the File menu to transfer a file to a connected handheld when you want to

save a file to a specific folder on the handheld.

1. Ensure the handheld is connected to the computer.

2. Inthe Computer panel, navigate to the folder where the file is located.
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3. Click the file.

4. Click File > Save to Handheld. The Save to Handheld dialog box opens.

Save to Handheld x

Lookin: |Connected Handhelds ~]

Name

& TI-nspire Fa26

Document name: |Documentt.ins |

| Cancel ‘

5. Double-click the handheld name, and then navigate to the folder where
you want to save the file.

6. Click Save. The file is saved to the selected folder and the Save to
Handheld dialog box closes.

Handling Errors Resulting from Sending Folders

If you receive an error after attempting to send a file, it may mean the receiving
handheld has an operating system that does not support the transfer. To
resolve this, update the receiving handheld’s OS and try the send again.

Common Error and Notification Messages

Shown
on

Sending
handheld

Message and Description

“This folder structure is not supported on the receiving
handheld. The receiving handheld’s OS may need to be
updated, which you can do by selecting Send OS from the My
Documents menu.”

OK

If you get an error when sending a folder to an older TI-Nspire™
handheld, try updating the OS on the receiving handheld. If the
error persists, you may have to send the files individually.

Sending

“Transfer failed. Check cable and try again."“
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Shown Message and Description

on

handheld OK
This message is displayed if a cable is not attached to the sending
handheld’s link port. Remove and then reinsert the cable and try
the document transmission again.
Click OK to cancel the transmission message.
Note: The sending handheld may not always display this
message. Instead, it may remain BUSY until you cancel the
transmission.

Sending “Receiver does not have enough storage space for file

handheld transfer."

OK

This message indicates that the receiving handheld does not have
enough memory to accept the file being transmitted.

The user of the receiving handheld must free space to obtain the
new file. To do this:

. Delete unneeded files.

+  Store files on a computer for later retrieval, and then delete
them from the TI-Nspire™ handheld.

Sending “<folder>/<filename> transferred as <folder>/<filename (#)."
handheld

This message is displayed at the end of a successful transfer
when the file had to be renamed because a file already exists on
the receiving handheld with the original name. The transmitted file
is renamed by appending a number to the end of the name.
Rename numbering always begins with (2) and can increment by
one, as needed.

Sending “<folder>/<filename> transferred as <folder>/<new
handheld filename>.™

This message indicates that a new folder was created on the
receiving handheld to contain the transmitted document.
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Shown
on

Receiving
handheld

Message and Description

“<folder>/<filename (x)> received.“

This message indicates that the receiving handheld has a
document with the same name as the document being sent.

Receiving
handheld

“<new folder>/<new filename> received.™“

This message indicates that a new folder has been created to
contain the transmitted document.

Receiving
handheld

“Transfer failed. Check cable and try again."“
OK

This message indicates that the cable is not correctly attached to
the receiving handheld’s link port. Remove the cable then reattach
itand try the transmission again.

Click OK to cancel the transmission message.

96 Connecting Handhelds and Transferring Files



Memory and File Management

The TI-Nspire™ CX Handheld comes equipped with 192 MB of memory. Of the
total memory, 128 MB is dedicated to Flash storage and 64 MB is RAM. When
the operating system is loaded, and as documents are created and stored on
the handheld, memory is used and you may find that you need to free or
restore memory after several months of use. If there is insufficient memory on
the handheld, use one of the following options to restore space on the
handheld:

+ Delete documents and folders you no longer use.
+ Back up files and folders to another handheld or computer.

+ Resetthe memory, which deletes ALL files and folders on the handheld.

Checking Available Memory

Complete the following steps to view the amount of memory (in bytes) used by
all documents and variables on your handheld.

1. From the Home screen, select Status from the Settings menu.

Press (5] (4].

The Handheld Status window opens.

|Handheld Status

Eatteries: F 100% (]

Varsion: 3.0.0.1014
Avatlable Space: 96 .10 ME out of 115.2 ME

Network: Wireless cradle is not attachsd.

Login: Not logged in.

2. View the Available Space field to determine how much memory is
available on the handheld.

3. Click OK to return to the Home screen.
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Freeing Memory

To free or recover memory, delete documents and/or folders from the
handheld. To keep the documents and folders for later use, transfer them to
another handheld or to a computer using the TI-Nspire™ software.

Deleting Files from the Handheld

1.
2.
3.

4.

Press to open the My Documents file browser.

Press a or w to select the folder or document you want to delete.
Press [o].

—or—

Press [ctn] (6].

A dialog box opens, asking you to confirm the deletion.

Mame o) Size
[5154

= Transfers—-T0-2/-T0

&6 Confirm Document Delete

Do sou really want to delete document
‘debbietest'?

[ Aehhipteat™

Press to confirm or to cancel.

The folder/document is permanently removed from the handheld.

Backing up Files to Another Handheld

1.

2
3.
4

Connect the two handhelds using the USB-to-USB connectivity cable.
Press to open My Documents on the sending handheld.
Press the a and v keys to highlight the document you want to send.
Press [menu], and then select Send.

—or—

Press [ctn] (2].

98 Memoryand File Management



5. When the file transfer is complete, a message is displayed on the receiving
unit.

Transferring Files to a Computer

Use the TI-Nspire™ software to transfer files and folders from a handheld to a
computer.

1. Connectyour handheld to the computer using a standard A to mini-B USB
cable.

2. Inthe TI-Nspire™ software, open the Documents Workspace.

3. Inthe Documents Toolbox, click " to open the Content Explorer.

[ computer 5 Computerpane

Lookin: [TI—Nspire | e

MName = Size
|) Backups

i) Calculator

i) Downloads

I5) Examples

IC5) Folder2

IC3) Folder3

) Folderd

[§l Connected Handhelds S

Connected Handhelds
pane

Lookin: |Connected Handhelds = g

Mame =
[ Ti-Mspire Fa26

4. Inthe Computer pane, navigate to the folder in which you want to save the
files.

5. Inthe Connected Handhelds pane, double-click the handheld name to
view the folders and files on the handheld.
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[zl Connected Handhelds P

Lookin: |THNspire Fa26 > | G
IName Size
E3 Examples o
4 Folder1
4 myLib
E3 new folder
[ default_themes tns 17KB |=
[ Documentt.tns 3KB [}s
[ image_testtns 298 KB
[ test1.ins 1KB
[ themes.csv 1KB r_

6. Selectthe file or folder you want to save to the computer.
+ Click the file to select one file or folder at a time.

* To selectall files on the handheld, select the first file in the list, hold
down the Shift key, and then click the last file or folder in the list.

+ To selectrandom files, click the first file, and then hold the Ctrl key
while selecting additional files.

Note: If you select multiple files, itis saved as lesson bundle ( tilb file).
7. Drag the files to the folder in the Computer pane.

—or—

Select File > Save as.

The files are copied to the folder on the computer.

8. Verify that the files you need are available on your computer, and then
delete the files from the handheld.

Note: Those using the TI-Nspire™ Teacher Software or the TI-Nspire™
Navigator™ Teacher Software can also use options in the Content Workspace
to copy files from a handheld to a computer.

Resetting the Memory

Complete these steps only if you want to delete ALL files and folders on your
handheld.
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Caution: Before you reset all memory, consider restoring sufficient available
memory by deleting only selected data. If you reset all memory, the pre-
installed applications on your handheld will remain, but any applications that
have been downloaded in TI-84 mode will be deleted.

1. After making certain you want to clear all files, press to open the
My Documents file browser.

2. Press to open the context menu.
3. Select Delete All.

—or—

Press [c].

The Data Loss dialog box opens.

Mame o) Size

W Transfers=TT-4-"T0 [

This operation will delete all files and folders on
this device. Do wou wish to proceed?

|Cancel'

LT Qetaul_thermnes IR
[ Documentz 1K
[T Fyamnle1 jpl7q

4. Click OK to confirm that you want to clear the handheld memory.
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Updating the Handheld Operating System

To take advantage of the latest handheld features and updates, download the
latest operating system files from the Education Technology website
(education.ti.com). You can update the operating system (OS) on TI-Nspire™
handhelds using a computer and the following software:

+ TI-Nspire™ Teacher Software

*  TI-Nspire™ Student Software

* TI-Nspire™ CAS Teacher Software

*  TI-Nspire™ CAS Student Software

*  TI-Nspire™ Teacher Navigator™ Software

*  TI-Nspire™ CAS Teacher Navigator™ Software

In the classroom, you can use the TI-Nspire™ Docking Stations to upgrade the
OS on multiple handhelds at the same time.

You can also transfer the OS from one TI-Nspire™ handheld to another or from
one TI-Nspire™ CX handheld to another. However, handheld operating
systems are not interchangeable. You cannot transfer a CAS operating system
to a non-CAS handheld and you cannot transfer a TI-Nspire™ handheld
operating system to a TI-Nspire™ CX handheld.

What You Need to Know

+ Ifthere is notenough room on the receiving handheld for the upgrade, a
message is displayed. For more information, see Memory and File
Management.

*  OS upgrade operations do not delete user documents. The only time
documents are affected by an OS installation is if the receiving handheld
has a corrupted OS. In this situation, documents may be affected by OS
restoration. Itis a good practice to back up important documents and
folders before installing an updated operating system.

Warning: Upgrading the operating system will delete all TI-84 applications and
files. Before installing an OS upgrade, you should use Tl Connect to back up all
TI-84 applications and files to a computer. You can copy them back to the
handheld when the OS upgrade is complete.
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Before You Begin
Before beginning an OS download, ensure that batteries are at least 25
percent charged.

» To check the status of the rechargeable battery in TI-Nspire™ CX
handhelds, press (5] (4] to open the Handheld Status dialog box.

TI-Nspire™ Handheld: Press G (@.

When in OS download mode, the Automatic Power Down™ (APD™) feature
does not function. If you leave your handheld in download mode for an
extended time before you begin the downloading process, your batteries may
become depleted. You will then need to replace or recharge the batteries
before downloading the OS.

Finding Operating System Updates

For up-to-date information about available OS upgrades, check the Texas
Instruments website at education.ti.com.

You can download an OS upgrade from the Texas Instruments website to a
computer, and use a USB cable to install the OS on your TI-Nspire™ handheld.
You will need an Internet connection and the appropriate USB cable to
download the updates.

Checking for Handheld OS Updates

When using TI-Nspire™ software, you can quickly determine if your handheld
OS is up to date when the handheld is connected to a computer.

1. Open the TI-Nspire™ software and ensure the handheld is connected to
your computer.

2. In the Documents Workspace, click ] to open Content Explorer.
3. Inthe Connected Handhelds pane, select a connected handheld.
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Select Help > Check for Handheld OS Update.

If the operating system is current, the Check for Handheld OS Update
dialog box opens indicating that the operating system on the
handheld is up to date.

Check for OS Update ()

@ Your TI-Mspire CX operating system is up to date.

If the operating system is not current, the dialog box contains a
message indicating that a new version of the operating system is
available.

Click OK to close the dialog box.

Updating the Operating System

In the TI-Nspire™ software, you can select to upgrade the operating system on
a connected handheld from the following workspaces and menus:

Updating the Handheld Operating System 105



* Inall versions of the software, you can select Help > Check for
Handheld/Lab Cradle OS Update. Select a connected handheld in the
Content Explorer to activate this option. If the OS on the handheld is not
current, the dialog box indicates that there is an updated version of the
operating system. Follow the prompts to update the operating system.

* Inall versions of the TI-Nspire™ software, you can use options available in
the Documents Workspace:

- Open Content Explorer, select the handheld name, and then click =
and select Install OS.

- Select Tools > Install Handheld/Lab Cradle OS.

» Those using teacher versions of the TI-Nspire™ software can use options
available in the Content Workspace:

- In the Resources pane, right-click the name of a connected handheld,
and then select Install Handheld/Lab Cradle OS.

- Select the handheld name in the Preview pane, click ™ in the
Preview pane, and then select Install Handheld/Lab Cradle OS.

- Right-click the handheld name and select Install Handheld OS/Lab
Cradle OS.

Completing the OS Upgrade

When you select to update the OS on a handheld, the Select Handheld OS File
dialog box opens.
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Select Handheld OS5 File

LookIn: I.E Downloads

Tl-Mspire tco

File Name:

Files of Type: IHanclhs.'lcl OS5 File -

|- instaos | |- cancel|

The file displayed for selection defaults to the file type required for the selected
handheld.

1. Selectthe OS file:
» Ifyou are upgrading a TI-Nspire™ CX handheld, select TI-Nspire.tco

* Ifyou are upgrading a TI-Nspire™ CX CAS handheld, select
TI-Nspire.tcc

+ Ifyou are upgrading a TI-Nspire™ handheld, select TI-Nspire.tno
+ Ifyou are upgrading a TI-Nspire™ CAS handheld, select TI-Nspire.tnc

2. Click Install OS to download the OS and update the handheld. The
confirmation message “You are about to upgrade your handheld operating
system. Any unsaved data will be lost. Do you want to continue?” is
displayed.

3. Click Yes to continue.

The Installing OS dialog box opens indicating the progress of the
download. Do not disconnect the handheld.
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Installing OS =

Installing O5...

IMPORTANT! Do not disconnect during OS installation.

L A

4. When the download is complete, the Information dialog box opens
indicating that the OS file has been successfully transferred to the
handheld. You can disconnect the handheld.

Information

The O3 file has been successfully transferred to the handheld.
@ The handheld will take a few moments to install the OS and restart.

If you wish, you can disconnect the handheld from the computer now.

5. Click OK.

The updated operating system is installed on the handheld. When the
update is complete, the handheld reboots.

6. On the handheld, follow the prompts to:
+ Choose a preferred language.
+ Select a preferred font size.
7. When the Welcome screen opens, click OK.

The Home screen opens.
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Transferring the Operating System From Another Handheld

Note: You cannot transfer the OS on a TI-Nspire™ handheld to a TI-Nspire™ CX
handheld and you cannot transfer the OS on a CAS handheld to a non-CAS
handheld. The operating systems are not the same and are not
interchangeable.

To transfer the OS from one handheld to another:

1. Ensure any open documents on the receiving handheld are closed.
Connect the two handhelds using a USB mini-B to mini-B USB cable.
On the sending handheld, select My Documents from the Home screen.

Press [meny], and then select Send OS.
On a TI-Nspire™ handheld, press (menu).

LN

1. Mew Folder
2. Rename

3 Save As,

[# 4 Collapse
5 Close [ty 19K
B Send

¥ 7 Expand Al 306k

o 8 Collapse All Ok
i 0K

Ok

C Delete All B3k
[ New Lesson Bundle 1KE

5. On the receiving handheld, the message, “You are receiving an OS
Upgrade. Unsaved changes will be lost. Would you like to continue 7 is
displayed along with Yes and No response buttons. Select Yes to receive
the OS upgrade.

* IfYes is not selected within 30 seconds, the handheld automatically
responds with No, and the transmission is cancelled.

+ ltisimportant to save and close all open documents before performing
an OS Upgrade. Continuing with an OS Upgrade on a handheld with
an open, unsaved document will cause the loss of that data.

6. While the upgrade is in progress, the following messages are displayed on
the receiving and sending handhelds:
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*  “Receiving OS. Do not unplug cable.”
+  “Sending OS. Do not unplug cable.”

7. After the transfer completes, the sending handheld receives a completion
message and you can unhook the cable. The OS is automatically installed
on the receiving handheld. During the installation process, the “Installing
OS <version number>" message is displayed on the receiving handheld.

8. When the installation is complete, the “OS <version number> has been
installed. Handheld will now restart” message is displayed. The restartis
initiated. If the sending handheld is still attached to the cable, the

successful transmission message remains displayed on that handheld’s
screen.

Important:

. For each receiving handheld, remember to back up information as
necessary and install new batteries.

+  Be sure the sending handheld is on the Send OS screen.

Updating the OS on Multiple Handhelds

In the classroom, use the TI-Nspire™ Docking Station to upgrade the OS on
multiple handhelds at the same time.

In the teacher versions of the TI-Nspire™ software, you can transfer files from
the computer to multiple handhelds from the Content Workspace. See Using
the Content Workspace for more information about transferring files to
connected handhelds.

OS Upgrade Messages

This section lists the information and error messages that can be displayed on
handhelds during an OS Upgrade.

Shown I

on: Message and Description

Sending “Receiver does not have enough storage space. Make <xxxK>
handheld available.™

This message indicates that the receiving handheld does not
have enough memory available for the new OS. The space
requirementis shown so you know how much memory must be
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Shown

Message and Description

on:
cleared for the new operating system. Files can be moved to a
computer for storage to free the necessary space.

Sending “Receiver must change batteries before upgrading the 0S.™

handheld This message indicates that the batteries in the receiving
handheld need to be replaced. Send the OS Upgrade once the
batteries are replaced.

Sending “Receiver has a newer OS and cannot

handheld load this 0s.“

OK

This message indicates that the receiving handheld has a newer
OS version than the one being transmitted. You cannot
downgrade an OS.

Sending “Upgrade not accepted by receiver.“

handheld OK
This message indicates that the receiving handheld refuses the
upgrade.

Sending “OS has been transferred.

handheld You can now unplug.“

OK

This message indicates that the transfer is complete and it is safe
to unplug the cable from the sending handheld.

Sending “Sending OS. Do not unplug cable.™

handheld This message, along with a progress bar, is displayed while the
OS Upgrade is being transferred.

Both “Transfer failed. Check cable and try again.™

handhelds OK
The sending and/or receiving handheld is not properly connected.
Reinsert the cable into each handheld, and then try the
transmission again.

Receiving “You are receiving an OS Upgrade. Unsaved changes will be
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Shown
on:

handheld

Message and Description

lost.
Would you like to continue?"

Yes No

This message is displayed when an OS Upgrade is about to
begin. If you do not select Yes within 30 seconds, the system
automatically responds with No.

Receiving
handheld

“Receiving OS. Do not unplug cable.™

This message, along with a progress bar, is displayed while the
OS Upgrade is being transferred.

Receiving
handheld

“Installing OS.™

This message is displayed when the transfer is complete. ltis
shown to keep you informed of the handheld’s status.

Receiving
handheld

“OS has been installed. Handheld will restart.™
OK

This information message displays briefly before the handheld
automatically reboots.

Receiving
handheld

“Install was corrupted. Handheld will reboot. You will need
to retry OS upgrade."“
OK

An error occurred during the transmission and the installation was
corrupted. The handheld will reboot. After the reboot, reinstall the
OS Upgrade.
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Support and Service

Texas Instruments Support and Service

General Information: North and South America

Home Page: education.ti.com
KnowledgeBase and e-mail inquiries: education.ti.com/support
Phone: (800) TI-CARES /(800) 842-2737

For North and South America and
U.S. Territories

International contact information: education.ti.com/support/worldwide

For Technical Support

Knowledge Base and support by e-mail: ~ education.ti.com/support or
ti-cares@ti.com
Phone (not toll-free): (972) 917-8324

For Product (Hardware) Service

Customers in the U.S., Canada, Mexico, and U.S. territories: Always contact
Texas Instruments Customer Support before returning a product for service.

For All Other Countries:

For general information

For more information about Tl products and services, contact Tl by e-mail or
visitthe Tl Internet address.

E-mail inquiries: ti-cares@ti.com

Home Page: education.ti.com

Service and Warranty Information

For information about the length and terms of the warranty or about product
service, refer to the warranty statement enclosed with this product or contact
your local Texas Instruments retailer/distributor.
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Precautions for Rechargeable Batteries

Take these precautions when replacing rechargeable batteries:
» Use only the charger recommended for the cell or battery, or the one that
was provided with the original equipment.

+ Remove the cell or battery from the charger or alternating current adapter
when notin use or being charged.

* Use ofthe battery in other devices may resultin personal injury or damage
to equipment or property.

» Do not mix brands (or types within brands) of batteries. There is a risk of
explosion if a battery is replaced by the wrong type.

Disposing of Batteries

Do not mutilate, puncture, or dispose of batteries in fire. The batteries can burst
or explode, releasing hazardous chemicals. Discard used batteries according
to local regulations.
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